
 1 

 
 
 
 
 
 

Foxit PDF Editor 
 

Version 2.0 

 
 

User Manual 
 
 
 

© 2009 Foxit Corporation. All rights reserved. 

 
 
 
 
 
 



Installation 

 2 

Copyright © 2009 Foxit Corporation. All Rights Reserved.  
 
No part of this document can be reproduced, transferred, distributed or stored 
in any format without the prior written permission of Foxit. 
 
Anti-Grain Geometry - Version 2.3 
 
Copyright (C) 2002-2005 Maxim Shemanarev (http://www.antigrain.com) 
 
Permission to copy, use, modify, sell and distribute this software is granted 
provided this copyright notice appears in all copies. This software is provided 
ñas isò without express or implied warranty, and with no claim as to its 
suitability for any purpose. 

 
  

http://www.antigrain.com/
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END USER LICENSE AGREEMENT  

  

IMPORTANT NOTICE 

 
Thank you for choosing Foxit PDF Editor Product (PDF Editor). This license 
is the legal agreement (Agreement) between you, the customer who has 
acquired PDF Editor (ñYouò) and Foxit Corporation (ñFoxitò). Please read this 
agreement carefully.  
 
Foxit is only willing to provide PDF Editor to you on the condition that you 
accept all of the terms contained in this Agreement. You accept all of the 
terms by installing or using PDF Editor. 
  
If you did not acquire PDF Editor from Foxit, or an authorized Foxit distributor, 
then you may not enter into this Agreement or use PDF Editor. No other party 
has the right to transfer a copy of PDF Editor to you.  
 
If you are unwilling to accept this Agreement, do not use PDF Editor. If you 
have already paid for PDF Editor with having a prior opportunity to review this 
Agreement, and are now unwilling to agree to these terms, you may, within 
thirty (30) days after the date on which you acquired PDF Editor, return it to 
Foxit, or the authorized distributor from whom you acquired it, along with its 
original packaging and proof-of-purchase, for a full refund. 
 
Notwithstanding anything herein to the contrary, Foxit authorized distributors 
do not act as agents of Foxit, and such distributors may not enter into any 
contracts on behalf of Foxit Corporation. No authorized distributor has the 
authority to modify the terms of this Agreement.  

 

1. OWNERSHIP 
 

PDF Editor (exclusive of its physical packaging) is licensed. It is not sold, 
even if for convenience we make reference to words such as ñsaleò or 
ñpurchase.ò PDF Editor is protected by copyrights and other intellectual 
property rights. You agree that all worldwide copyright and other intellectual 
property rights in PDF Editor and all copies of PDF Editor, however made, 
are the exclusive property of Foxit. All rights in PDF Editor not expressly 
granted to you in this Agreement are reserved by Foxit. There are no implied 
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licenses under this Agreement. 
 

2. GRANT of LICENSE 
 
This agreement grants you the following rights: 
 
Installation and Usages - You may install and use one copy of PDF Editor on 
a single computer at a time and only by one user at a time. 
 
Network Storage/Use - You may also store or install a copy of PDF Editor on 
a storage device, such as a network server, used only to install or run PDF 
Editor on your other computers over an internal network; however, you must 
acquire and dedicate a license for each separate computer on which PDF 
Editor is installed or run from the storage device. 
 
Concurrent Use - A license for PDF Editor may not be used concurrently on 
different computers, however, this agreement does allow a licensed user to 
install PDF Editor on both a work computer and a home computer, provided 
the PDF Editor is not in use on both machines at the same time. 
 

3. OTHER RIGHTS AND LIMITATIONS 
 
Limitations on Reverse Engineering, Decompilation, and Disassembly - You 
may not reverse engineer, decompile, or disassemble PDF Editor, except 
and only to the extent that such activity is expressly permitted by applicable 
law not withstanding this limitation. 
 
Separation of Components ï PDF Editor is licensed as a single product. Its 
component parts may not be separated for use on more than one computer. 
 
Rental - You may not rent or lease PDF Editor. 
 
Software Transfer - You may permanently transfer all of your rights under this 
Agreement, provided you retain no copies, you transfer all of PDF Editor 
(including all component parts, the media and printed materials, any 
upgrades and this Agreement), and the recipient agrees to the terms of this 
Agreement. If your copy of PDF Editor is an upgrade, any transfer must 
include all prior versions of PDF Editor. 
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Termination - Without prejudice to any other rights, Foxit Corporation may 
terminate this Agreement if you fail to comply with the terms and conditions of 
this Agreement. In such event, you must destroy all copies of PDF Editor and 
all of its component parts. 
 
Development License Restrictions - These restrictions apply to a licensee 
who develops Application Software that utilizes PDF Editor in a commercially 
distributed application. 
 
(i) Must purchase a license of PDF Editor for each copy of the Application 
Software sold; 
(ii) PDF Editor is not the sole or primary component of such Application 
Software;  
(iii) You must give proper acknowledgment of the copyright of Foxit 
Corporation;  
(iv) Must not be used to create a software application that competes with or is 
intended to compete, directly or indirectly, with PDF Editor;  
(v) The Application Software must add significant value to the PDF Editor. 
 
All other uses that fall outside the scope of this Agreement must receive the 
written permission of Foxit. 
 

4. DOCUMENT COPYRIGHTS 
 
You should not use PDF Editor to alter protected PDF documents without a 
valid password or permission granted by the copyrights owner. Furthermore, 
for unprotected PDF documents, you must also observe the copyrights of the 
documents. Foxit will not be liable to any loss caused directly or indirectly by 
copyrights infringing when you use PDF Editor to alter documents in any 
improper way. 
 

5. LIMITED WARRANTY 
 
Foxit, warrants that PDF Editor contained herein will, for a period of thirty (30) 
days from the date of delivery, perform substantially in accordance with the 
accompanying documentation. NO OTHER WARRANTIES. Foxit disclaims 
all other warranties, either express or implied, including but not limited to 
implied warranties of merchantability and fitness for a particular purpose, with 
respect to the Software, the accompanying written materials. 
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In the event of any breach of warranty or other duty owed by Foxit, Foxit's 
entire liability and your exclusive remedy shall be, at Foxitôs option, either (a) 
return of the price paid by you for the product (not to exceed the suggested 
U.S. retail price) if any, (b) repair or replacement of the defective product. 
This Limited Warranty is void if failure of the product has resulted from 
accident, abuse, or misapplication. Any replacement product will be 
warranted for the remainder of the original warranty period or ten (10) days, 
whichever is longer. 
 

6. NO LIABILITY FOR CONSEQUENTIAL DAMAGES 
 
In no event shall Foxit be liable for any damages whatsoever (including but 
not limited to damages for loss of business profits, business interruption, loss 
of business information, or any other pecuniary loss) which results from the 
use or inability to use PDF Editor, even if Foxit has been advised of the 
possibility of such damages. Because some states/jurisdictions do not allow 
the exclusion or limitation of consequential or incidental damages, the above 
limitations may not apply to you. 
 

7. UPDATES AND SUPPORTS 
 
When you purchase a Foxit Editor license from Foxit, you receive more than 
the usual right to use the current version of the software. Along with a 
perpetual license to the current official version of the product, you receive the 
following:  
 

 ̧ Unlimited access to software updates for one year from the date of 
license purchase, with no limit on minor or major release.  

 ̧ Unlimited free technical support by e-mail for one year.  
 
To receive the above services, you need to register your purchased copy of 
PDF Editor with Foxit. Upon registration, Foxit will collect your information 
including name of you or your organization, email address as well as unique 
CD key of your purchased copy of PDF Editor. Foxit will retain those 
information for providing the above services. Foxit will not reveal your 
information to any third party unless required doing so by law. 
 

8. GOVERNING LAWS  
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If PDF Editor was purchased in the United States, this Agreement is 
governed by the laws of the state of California; otherwise, local laws may 
apply. 
 

9. GENERAL PROVISIONS 
 
If any part of this Agreement is found void and unenforceable, it will not affect 
the validity of the balance of this Agreement, which shall remain valid and 
enforceable according to its terms. This Agreement shall not prejudice the 
statutory rights of any party dealing as a consumer. This Agreement may only 
be modified by a writing signed by an authorized officer of Foxit. Updates 
may be licensed to you by Foxit with additional or different terms. This is the 
entire agreement between Foxit and you relating to PDF Editor and it 
supersedes any prior representations, discussions, undertakings, 
communications or advertising relating to PDF Editor. 
 
Should you have any questions concerning this Agreement or if you desire to 
contact Foxit Corporation for any reason, please write to Foxit Corporation, 

39819 Paseo Padre Parkway, Fremont, CA 94538, USA, or send us an 
email at sales@foxitsoftware.com. 

 
  

mailto:sales@foxitsoftware.com
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Chapter One - Introduction 

 
Welcome to Foxit PDF Editor from Foxit Corporation. The Foxit 
PDF Editor extends the usability of PDF documents by enabling 
the user to edit PDF files in a WYSIWYG (What You See Is What 
You Get) way. Foxit PDF Editor is proud to be the first, and up to 
the time when this manual was printed, the only PDF Editor that 
allows you to modify existing PDF documents in an easy and 
efficient way, yet retain all rich features for viewing and printing 
provided by PDF document format.  
 
The Foxit PDF Editor is a revolutionary program in editing PDF 
files. Its goal is to give the user a friendly editing interface and 
make the user feel that they are editing a common document, like 
with a common editor. Foxit PDF Editor offers the user flexibility 
to modify or customize anything in the page contents of a PDF 
file. 
 
 
This chapter covers the following sections: 
 

 ̧ PDF Document Concepts   
 ̧ Why Foxit PDF Editor  
 ̧ PDF Document Copyrights Issue  
 ̧ Whatôs New  
 ̧ About this Manual  
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PDF Document Concepts 

PDF stands for Portable Document Format, which can be used to exchange 

and distribute documents in a manner independent of the application 

software, hardware, and operating system used to create it. 
 
A PDF document contains one or more pages. Each page in the document 
may comprise a sequence of objects. An object can be a text object which 
consists of a number of text characters, a graph object which contains 
straight lines, rectangles, and cubic curves, or an image object which is 
made of a set of colored pixels. 
 
Each object contains a series of attributes that determine what the object 
looks like. Text Objects use fonts to specify how the characters look, and 
font sizes to specify how large those characters are. Graph objects have 
attributes like line, width, and fill type. All objects have common attributes 
like position, size, and orientation. There are many more attributes defined 
for PDF page objects, please refer to Chapter Seven ñWorking with Objectsò 
for a detailed explanation of all object attributes. 
 

Why Foxit PDF Editor   

Directly edit PDF documents! As the PDF becomes more important in the 

field of document publishing, people have an increasing need to use and edit 

PDF documents.  
 
This demand had led to the conversion of PDF to other types of files, such as 
Microsoft Word file. This however usually causes data or format lost during 
the conversion of the PDF file. PDF files are converted into other types of files 
and then converted back to PDF. Very often, too many things have been 
changed during double conversion, hence, the user has to almost rebuild the 
whole document structure. 
 
What if there is a way to edit PDF documents directly that is reliable and easy 
to use? The answer is Foxit PDF Editor, the first and only REAL editor for 
PDF files. 
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PDF Document Copyrights Issue 

Many PDF documents come with copyrights reserved by the author, or owner 

of the intellectual property. And in many cases the owner of copyrights may 

prohibit anyone else to alter the document in any way. 
 
Foxit PDF Editor by no means is designed to breach those copyrights. 
However, itôs up to you, the user of Foxit PDF Editor to observe the copyright, 
if the document is not protected in any technical way. 
 
With Foxit PDF Editor, you are able to edit any user password protected 
documents. But you can only Save As the document if you have no password. 
If a document is not protected by password, but encrypted and with 
modification permission prohibited, you cannot edit it with Foxit PDF Editor. 
 

Whatôs New 

Foxit PDF Editor 1.0 

In March 2004, after one year of extensive development, Foxit Corporation 
introduced the first version of Foxit PDF Editor. It provided users with the 
ability to change PDF files that no other tools have provided before. All basic 
editing features have been built in this initial version, making it the first and 
only real editor for PDF files. 

Foxit PDF Editor 1.1 

Released in June 2004, Foxit PDF Editor 1.1 added even more convenience 
and capabilities for working with complicated PDF files: 
 

 ̧ Enhanced document manipulation like copy and paste, redo and undo, 
save and rollback saving, etc. 

 
 ̧ Page manipulation - user can now insert and delete pages, and 

configure page size. 
 

 ̧ Import Windows font ï user can import Windows fonts to be used in any 
text object.  
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 ̧ Graphic Keyboard for Embedded Font ï user can use a Graphic 

Keyboard to edit the text objects with embedded fonts. 

Foxit PDF Editor 1.2 

The new features of the Foxit PDF Editor 1.2 include: 
 

 ̧ New Color Spacing Settings in PDF Editing Options for changing the 
displaying color mode. 

 
 ̧ New Split Text Option for splitting one integrated text object into two or 

several part so that you can easily move the text part you want. 
 

 ̧ New image formats are supported like GIF and JPG. 
 

 ̧ New Clockwise and Anti-clockwise Rotate option for changing the 
object orientation. 

 
 ̧ New Object Attribute Modify Mode. All selected object(s) attributes are 

displayed in the Attribute Modify Pane which in before version only the 
common attributes of the selections are shown.  

Foxit PDF Editor 1.3 

 ̧ In-place editing allows you to quickly make changes to your 
documents. 

 
 ̧ New user-friendly interface for ñImport Windows Fontò. 

Foxit PDF Editor 1.4 

 ̧ Page level operations: you can import/export PDF pages, or change 
page layout. These new features are accessible from "Page" menu.  

 
 ̧ Graphic Editor: you can use a simple but useful graphic editor to 

change any graphic shapes (lines, polygons, curves, stroked, filled, etc.). 
You can insert whole new graphic objects (select "Object: Add Graph: 
Add New Graphic" menu item) or modify existing ones (select "Graphic 
Editing" from popup menu when you right-click on a graphic object).  
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 ̧ Clipping Editor: you can add/modify/remove clipping layers of any 

visual object so the visible part of the object can be anything you want 
(find all the new clipping features in the "Clipping" pane). 

 
 ̧ Image Editor: you can make some simple but useful changes to any 

existing image (select "Image Editing" from the pop-up menu when you 
right-click on an image object).  

Foxit PDF Editor 2.0  

 ̧ New Toolbars: Toolbars have been renovated thoroughly. New buttons 
for many functions have been added to the toolbars. These toolbars look 
professional and will greatly increase usersô productivity. 

 ̧ Improved Status Bar: Now, users can specify page number or zooming 
factor in status bar. 

 ̧ Floating Property List̔Newly-designed property list can be dragged 

anywhere in the screen and hid or shown anytime. This allows users to 
view any part of a page. Users will be able to modify object properties 
and see the changes come to effect instantly. In addition, special setting 
dialogs can be invoked for users to change complex settings, such as 
colors setting, clipping setting and dashing line setting. 

 ̧ Default Settings: Version 2.0 allows a user to specify more default 
settings of parameters and behaviors inside Edit/Option dialog. 

 ̧ Drag Action: In previous versions, a user had to explicitly enter values 
to specify many parameters. Now with Version 2.0, a user can use a 
mouse to drag the control points of an object to manipulate it and set the 
parameter implicitly. For instance, a user can drag the control point of a 
text object to resize it. 

 ̧ Flexible Image Editor U̔sers may double click on an image to enter the 

image editor.  
Â Several new tools have been added to image editor, including 

Magic Wand tool, Polygonal Lasso tool, and Layer tool.  
Â Other tools have been improved, including Selection tool, Dodge 

tool, and Burn tool.  
Â In previous versions, users can only undo or redo the latest action 

in Image Editor. This new version allows users to Undo/Redo 
multiple steps, as long as the program doesnôt reach the memory 
limit of the PC.  
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Â With Version 2.0, a user can edit images from multiple PDF files at 
the same time which is impossible in previous versions. The user 
can copy and paste image areas across different files.  

Â Several short-cut keys have been added to speed up image 
operations. 

 ̧ Intuitive Graphics and Clipping Editor:  In previous versions, 
graphics and clipping path are edited in separate small dialogs which do 
not show the PDF page content behind the path. This is very unintuitive. 
Version 2.0 allows users to edit them in the main window, with a bigger 
and consistent view showing the PDF content behind them.  

 ̧ Intuitive Layout Editor: In previous versions, layout is edited in a 
separate small dialog. Version 2.0 allows users to edit it in the main 
window, with a bigger and consistent view. 

 ̧ Editing Encrypted PDF: Version 2.0 allows users to read and edit 
encrypted PDF files, which is a new and useful feature. 

 ̧ Extensibility: Version 2.0 adopts a new framework consolidating 
different function modules and allowing for future extension to add more 
modules, e.g. form design module. 

 ̧ And much more. 
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Chapter Two ï Installing Instructions 

This chapter describes the system requirements and installation 
of Foxit PDF Editor. 

 
 
          The following sections are included: 
 

 ̧ System Requirements 
 ̧ Installing Foxit PDF Editor 
 ̧ Uninstalling Foxit PDF Editor 
 ̧ Installing License Key 
 ̧ Registering Foxit PDF Editor 
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System Requirements 

Foxit PDF Editor runs on the following Windows operating system: 
     

 ̧ Windows 2000         
 ̧ Windows XP     
 ̧ Windows Server 2003  
 ̧ Windows Vista  

 

Installing Foxit PDF Editor 

Procedure One ïDownload the Package 
 
Foxit PDF Editor is distributed via web download. If you have downloaded full 
retail package, you just need to UNZIP the package into a temporary folder, 
and then start the ñsetup.exeò application.  
 

Procedure Two ï Installing the Software 
 
After running the Foxit PDF Editor setup program, you will need to execute 
the following steps to finish setup: 
 
1. Welcome Screen ï Click Next button to continue, click Cancel button to 

abort the setup. 
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Welcome Screen 

 
2. License Agreement -- What you are seeing is Foxit PDF Editor License 

Agreement (see the following figure). This is common for nearly all 
software. Only after you click "I agree" button to grant your acceptance 
can you continue to install. 
 

 
License Agreement 

 
3. Choose Installation Type: 
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Installation Type Choosing Screen 

 
In this screen you can click Default button to expressly finish Foxit PDF 
Editor setup, or click Custom button to complete the setup step by step.  
 

If you select Default, you agree to use the default setup configuration 
that Foxit has preset for the installation. The setup progress proceeds in 
the background, and very soon Foxit PDF Editor will be launched for you 
to use. Here is a list of the default setup configurations: 
 

 ̧ The destination folder is set to ñC:\Program Files\Foxit 
Software\PDF Editorò. 

 ̧ A desktop shortcut Foxit PDF Editor.exe is created. 
 ̧ A "Program Group" called "Foxit PDF Editor" is created, it includes 

two shortcuts, the first is Uninstall, and the second is PDF Editor.   
 ̧ The program is added to the Control Panel > Add or Delete 

Program. 
 ̧ A registry key is created as" HKEY_LOCAL_MACHINE\Software\ 

Foxit Software\PDF Editor ". 
 ̧ The Foxit PDF Editor installation directory is added to the system 

path.  
 ̧ Foxit PDF Editor program is auto run after setup is finished. 
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If you select Custom, you can change the default settings, but have to 
configure the setup one by one. Here are steps you will experience in 
the custom installation: 
 
First, after you click Custom button, you will see the following screen: 
 

 
Settings Screen 

 
 ̧ Destination folder: You can directly input a destination path in this 

box, or click on Browse button to select a destination folder for Foxit 
PDF Editor. 

 
 ̧ Add a desktop shortcut: Check the box will create a shortcut of 
Foxit PDF Editor.exe on desktop. If you donôt want a desktop 
shortcut, uncheck it. 

 
 ̧ Add an Icon in the Start Menu: Check the box will create a 

shortcut of Foxit PDF Editor.exe on the Start menu. If you donôt 
want a Start menu shortcut, uncheck it. 

  
Now, click Next button to continue the setup, and you should see the 

following screen̔ 
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Confirmation Screen 

 
This screen lists all setup settings you have selected in the previous step. 
You can click Back to change the settings, or click Install to enter into 
the next screen show as below: 
  

 
Finishing Screen 

 
     The Run Foxit PDF Editor.exe is checked by default. And when you 

click Finish button the Foxit PDF Editor program will automatically be 
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launched. If you donôt want auto run Foxit PDF Editor after installation, 
uncheck the box. 

 

Uninstalling Foxit PDF Editor 

To uninstall Foxit PDF Editor, do one of the following: 
 

 ̧ Click Start > All Program Files, and find Foxit PDF Editor, and last 
click Uninstall. 

 ̧ Select Control Panel > Delete or Add Program, and then select Foxit 
PDF Editor to uninstall. 

 ̧ Find the PDF Editor installation directory named ñFoxit Softwareò, and 
then select Uninstall.  
 

Installing License Key 

1. If you purchase online, you will be able to immediately download a small 
temporary key. 

 
 ̧ Downloading a Temporary License Key 

 
1) Make sure you know the folder where you have put PDF Editor. If 

you don't know, please do a search on your computer for 
"pdfedit.exe".  The default is: ñC:\Program Files\Foxit 
Software\PDF Editorò. 

 
2) Immediately after you purchase Foxit PDF Editor, you will be asked 

to download a temporary license key. 
 

3) Press the "Download Temporary License Key" button as shown 
below: 
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4) In the file download prompt box, click Save button to store the key 
file into where the PDF Editor is saved. The temp key file name is 
ñpedkey.txtò.  

 
Notes:  

    
 ̧ The key file must keep its original name (pedkey.txt). 
 ̧ The key file must store into the same folder with PDFEditor.  

 
5) Finally, double click on PDF Editor or pdfedit.exe to run the 

application without any limitation. 
 

2. After your online purchase order verified, Foxit will send you a formal 
license key within an email. The license key is sent as a attachment with 
its name as ñpedkey.txtò 

  
   Here are two examples on how you can save the license key in the 

Outlook Express and Open Web Mail. 
 
   Using Outlook Express  
 

1) Close Foxit PDF Editor window, and open the Foxit mail with formal 
license key in your Outlook mail list. 

 
2) Click the attachment file, and click Save Attachment menu. 
  
3) In the pop-up Save As dialog box, click Browse button to search the 

folder where PDFEditor.exe is saved, and then save the pedkey.txt 
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into that folder.  
 

Note: pedkey.txt must be stored into the right place where 
PDFEditor.exe exists; otherwise the product will not be licensed. 
 

4) Restart the PDFEditor.exe and it is licensed. 
    

Using Open Web Mail 
 

1) Double click the Foxit mail with formal license key in the Inbox of 
your Open Web Mail. 

 
2) Scroll down the Message Display window to the message bottom, 

and you can find a small attachment prompt box shown as below: 
 

 
 
3) Right click the Download link and Choose Save Target As menu. 

 
4) In the pop-up Save As dialog box, click Browse button to search the 

folder where PDFEditor.exe is saved, and then Save the pedkey.txt 
into that folder.  

 
Note: pedkey.txt must be stored into the right place where 
PDFEditor.exe exists; otherwise the product will not be licensed. 
 

5) Finally, when the PDFEditor.exe is restarted, it should be licensed. 
 

Registering Foxit PDF Editor 

After purchasing Foxit PDF Editor, please do one of the following to register 
your key:  
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 ̧ Close Foxit PDF Editor, save the key file into the directory where you 
installed the application. 

 ̧ Run Foxit PDF Editor > Help > Install License Key > A registration box 
will pop up. Open the received key file, copy the key contents into the 
box indicated > click the Register the Key button. 

Note: To check if you have registered successfully, please go to ñHelpò > 
ñAbout PDF Editorò and see if your name is shown at the bottom left corner.  

After registering successfully, you can remove all the evaluation marks which 
are added by Foxit PDF Editor 2.0 at one time before you purchase it. To 
remove all the evaluation marks, please select ñHelpò > ñRemove Evaluation 
Marksò. 
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Chapter Three - Quick Start Guide 

This chapter helps you to quickly get started with Foxit PDF 
Editor. 

 

This chapter contains the following sections: 

 ̧ Insert New Objects 
 ̧ Select Objects 
 ̧ Change Object Attributes 
 ̧ Edit Text Objects 
 ̧ Edit Graphic Objects 
 ̧ Edit Image Objects 
 ̧ Edit Page Layout 
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Inserting New Objects 

You can insert text, graphic, and image objects. 

 

 

Ŷ Insert text From 

the Object toolbar,  click Add 

Text Objects button . In the 

Add new text objects dialog box, 
input any text you want, and click 
OK to insert. 

Note: To insert more than one 
line, you can simply press Ctrl + 

Enter to start a new line. 

ŵ  Open an existing PDF file 

to be edited, or create a 

new page using New button 
or pressing Ctrl + N. On the 
left is the example of a 

blank new page. 

Create a new blank page 

Please input text here 

Add Text Objects 



Quick Start Guide 

 29 

  

 

 

 

ŷ  Insert Graphics 
From the Object toolbar,  click Add 

a Graphic Object button , and 
you will be switched to the Graphic 

Editor window.   

Add a Graphic Object 

Path toolbar 

Insert Graphics  

Select a tool from the Path toolbar 

to draw a path you want. After you 
are done, click the Save and Exit 

button  to go back to document 
window. In the picture on the left we 

drew an ellipse as an example. 

Ÿ Insert Images  

To insert an existing image from file, 

click Loading an Existing Image 

button  to insert the image. To in 

sert a self-created image, click 

Create a New Image button , 

or go to Object > Add Image > New 
Image, or press Ctrl + I.  
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Selecting Objects 

Before you can delete or change any existing object, you must select the 
object.  

 ̧ You can select an object by simply clicking on the object itself.  
 ̧ There might be more than one object overlapping each other. In this 

case, you might need to click on the same place several times to pick up 
the correct object. Attributes of the selected objects are displayed in the 
Properties pane.  

 ̧ You can select multiple objects by holding down CTRL key when you 
select objects with the mouse.  

Insert Images  

After selecting Loading an Existing 
Image button, you can search the 

image in the Open dialog box.  

Insert Images  

After selecting Create a New Image 
button, you will be switched to the 
Image Editor window. Here, you 

can create a new image from 
scratch by yourself. After you are 
done, click Save to insert the image 

and go back to the main window. 
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 ̧ You can also select many objects at one time if you click on an 
unselected area and drag your mouse pointer while holding the mouse 
button down. In this case, all objects completely within the rectangle 
created by the drag of the mouse will be selected. 

Changing Object Attributes 

You can freely change attributes of any selected object(s) by Properties 
pane. 

 

 

 

ŵ  Open an existing PDF file 

that you want to be edited. 
Select an object, or hold 

down CTRL to select 
multiple objects. Here we 
select the text, graphic and 

image objects as example. 

Ŷ The Properties pane changes 

to reflect the object you select. You 

can use the General tab to change 
the common attributes to the objects 
you selected. Or, you can use the 

Text tab to change text attributes, 
Path tab to change the graphic 
attribute, or the Image tab to change 

the image attributes. After you are 

done, press the Enter key. 


